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CÂU HỎI TRẮC NGHIỆM 

MÔN TIN HỌC ĐẠI CƯƠNG 

Câu 1. Trong Word, muốn tắt/ mở thanh Standard ta sử dụng thao tác nào? 

A. Edit/Toolbars/Standard 

B. View/Toolbars/Standard  

C. Insert/Toolbars/Standard 

D. Format/Toolbars/Standard 

Câu 2. Trong Table của Word, để gõ kí tự Tab ta thực hiện thao tác nào? 

A. Tab 

B. Shift + Tab 

C. Ctrl + Tab 

D. Alt + Tab 

Câu 3. 

Trong Table/Sort của Word, hỗ trợ tối đa bao nhiêu tiêu chí sắp xếp? 

A. 3 

B. 2 

C. 4 

D. 1 

Câu 4.Trong Word, Format/Drop Cap/Lines to drop có chức năng gì? 

A. Xác định số dòng cần drop 

B. Xác định vị trí kí tự drop cap 

C. Xác định khoảng cách từ drop cap đến văn bản 

D. Xác định font chữ cho kí tự drop cap 

Câu 5. Trong Word, có mấy cách tạo chữ Word Art?  

A. 1  

B. 3  

C. 4  

D. 2 

Câu 6. Trong Table của Word, có mấy dạng canh lề? 

A. 4 

B. 9 

C. 8   

D. 6 

Câu 7. Trong Word, muốn kẻ đường thẳng cho thật thẳng, phải nhấn phím gì trước khi kéo 

chuột. 
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A. Ctrl 

B. Shift 

C. Ctrl + Alt 

D. Alt + Shift 

Câu 8. Trong Word, để in trang hiện hành, ta chọn thao tác nào? 

A. File/ Print chọn All 

B. File/ Print chọn Pages 

C. File/ Print chọn Current page 

D. File/ Print chọn Selection 

Câu 9. Trong Word, để chép nội dung từ bộ nhớ tạm ra vị trí con trỏ, ta sử dụng tổ hợp phím 

nào? 

A. Ctrl + V 

B. Ctrl + E 

C. Ctrl + X 

D. Ctrl + C 

Câu 10. Trong Word, để cắt vào bộ nhớ tạm một đoạn văn bản đã được chọn, ta chọn thao tác 

nào? 

A. Edit/Paste 

B. Edit/Copy 

C. Insert/Cut 

D. Edit /Cut  

Câu 11. Trong Word, để biết đang sử dụng Word phiên bản nào: 

A. Nhấn Help, chọn About Microsoft Word 

B. Nhấn Tools/ Options 

C. Nhấn Windows/ Split 

D. Nhấn File/ Properties 

Câu 12. Khi soạn thảo văn bản, giả sử ta cần thay thế chữ "Đh Ktcn Tp.Hcm" thành chữ "ĐH 

Kỹ Thuật Công Nghệ TP.HCM" ta thực hiện lệnh: 

A. Edit/ Replace 

B. Edit/ Find 

C. Chọn "Đh KtCn Tp.HCM" rồi nhấn tổ hợp phím Shift + F3 

D. Không thể thực hiện được 

Câu 13. Trong Word, để gạch ngang một đoạn văn bản giống câu hỏi này, ta chọn thao tác 

nào? 

A. Format/Font/Subscript 

B. Format/Strikethough 
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C. Format/Font/Superscript 

D. Format/Font/Strikethough 

Câu 14. Trong Word, để cắt vào bộ nhớ tạm một đoạn văn bản đã được chọn, ta chọn thao tác 

nào? 

A. Ctrl + C 

B. Ctrl + V 

C. Ctrl + X 

D. Ctrl + A 

Câu 15. Trong Word hỗ trợ sao lưu văn bản soạn thảo thành các định dạng nào? 

A. *. doc; *.txt và *.exe 

B. *.doc; *.htm và *.zip 

C. *.doc; *.dot; *.htm và *.txt 

D. *.doc; *.dat; *.xls và *.avi 

Câu 16. Trong Word, muốn xem văn bản trước khi in, ta chọn thao tác nào? 

A. Edit/ Print Preview 

B. View/Print Preview 

C. File/Print 

D. File/Print Preview  

Câu 17. Trong Word, để canh thẳng lề trái cho một đoạn văn bản đã được chọn, ta sử dụng tổ 

hợp phím nào? 

A. Ctrl + R 

B. Ctrl + C 

C. Ctrl + L 

D. Ctrl + J 

Câu 18. Trong Word, để gõ công thức toán học, ta chọn thao tác nào? 

A. Insert/Object/Microsoft Equation 

B. View/ Microsoft Equation 

C.  Edit/ Microsoft Equation 

D. Tools/Object/Microsoft Equation 

Câu 19. Trong Word, để đưa con trỏ về đầu văn bản, ta sử dụng tổ hợp phím nào? 

A. Ctrl + Home 

B. Ctrl + End 

C. Shift + Home 

D. shift + End 

Câu 20.Trong Word, biểu tượng giống cây chổi  có chức năng gì? 

A. Sao chép nội dung văn bản 
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B. Canh lề  văn bản 

C. Sao chép định dạng 

D. Mở văn bản đã có 

Câu 21. Trong Word, để kết thúc một đoạn và sang đoạn mới, ta chọn thao tác nào? 

A. Shift + Enter 

B. Enter 

C. Alt + Enter 

D. Alt + Shift 

Câu 22. Trong Word, để chép nội dung từ bộ nhớ  tạm ra vị trí con trỏ, ta chọn thao  tác trên 

menu nào? 

A. Insert /Cut 

B. Edit /Paste 

C. File /Copy 

D. Edit /Copy 

Câu 23. Trong Word, để chèn một tập tin hình ảnh trong thư viện hình ảnh của Word vào văn 

bản, ta chọn thao tác trên menu nào? 

A. Insert/Picture 

B. Insert/Object 

C. Insert/Picture/ClipArt 

D. Insert/Picture/From File 

Câu 24. Trong Word, để di chuyển nhanh đến một trang nào đó trong văn bản, ta sử dụng tổ 

hợp phím nào? 

A. Ctrl + L 

B. Ctrl + E 

C. Ctrl + R 

D. Ctrl + G  

Câu 25. Trong Word, chức năng Table/Convert dùng để: 

A. Chuyển chữ hoa cho toàn bộ đoạn văn bản 

B. Chuyển chữ hoa đầu từ cho toàn bộ đoạn văn bản 

C. Làm to ký tự đầu tiên của đoạn. 

D. Chuyển từ table sang text và ngược lại. 

Câu 26. Trong Word để lưu 1 tập tin ta dùng lệnh hay phím tắt nào 

A. Ctrl – O 

B. Ctrl – S 

C. File  Save  

D. Câu B, C đúng 
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Câu 27. Trong Word để lưu 1 tập tin với tên khác ta dùng lệnh hay phím tắt nào 

A. Ctrl – U 

B. Ctrl – S 

C. File -> Save As  

D. Câu A, C đúng 

Câu 28. Trong Word để mở 1 tập tin ta dùng lệnh hay phím tắt nào 

A. Ctrl – O 

B. Ctrl – S 

C. File -> Open 

D. Câu A, C đúng 

Câu 29. Trong Word để mở 1 tập tin ta dùng lệnh hay phím tắt nào 

A. Ctrl – I 

B. Ctrl – S 

C. File -> Open 

D. Câu A, C đúng 

Câu 30. Trong Word để đóng 1 tập tin ta dùng lệnh hay phím tắt nào 

A. Ctrl – O 

B. Ctrl – S 

C. File -> Close  

D. Câu A, C đúng 

Câu 31. Trong Word để tạo mới 1 tập tin ta dùng lệnh hay phím tắt nào 

A. Ctrl – I 

B. Ctrl – N 

C. File -> New 

D. Câu B, C đúng 

Câu 32. Trong Word để tạo mới 1 tập tin ta dùng lệnh hay phím tắt nào 

A. Ctrl – O 

B. Ctrl – F 

C. File -> New  

D. Câu B, C đúng 

Câu 33. Trong Word để Tìm kiếm 1 đoạn văn bản ta dùng lệnh hay phím tắt nào 

A. Ctrl – F 

B. Ctrl – S 

C. Edit  Find 

D. Câu A, C đúng 

Câu 34. Trong Word để Tìm kiếm 1 đoạn văn bản ta dùng lệnh hay phím tắt nào 
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A. Ctrl – F  

B. Ctrl – S 

C. Edit  Seach 

D. Câu A, C đúng 

Câu 35. Trong Word để khôi phục 1 thao tác ta dùng lệnh hay phím tắt nào 

A. Ctrl – Z 

B. Edit  Undo 

C. Câu A, B đúng 

D. Câu A, B sai 

Câu 36. Để gõ được dấu tiếng Việt trong văn bản ta chọn bảng mã và font chữ nào 

A. Bảng mã Unicode, Font Arial 

B. Bảng mã Unicode, Font Vni-times 

C. Bảng mã VNI Windows, Font Vni-Times 

D. Câu A, C Đúng 

Câu 37. Để gõ được dấu tiếng Việt trong văn bản ta chọn bảng mã và font chữ nào 

A. Bảng mã Unicode, Font Vni-times 

B. Bảng mãUnicode, Font .VNtime 

C. Bảng mã VNI, Font Arial 

D. Các câu trên đều sai 

Câu 38. Để định dạng Font chữ cho văn bản ta dùng lệnh 

A. Format - Paragraph 

B. Format - Font  

C. Edit - Font 

D. Edit - Paragraph 

Câu 39. Để tạo Đường viền và màu nền trong văn bản ta dùng lệnh 

A. Format / paragraph 

B. Format / Shading 

C. Format / Border and Shading 

D. Format / Border 

Câu 40. Để tạo các số đầu đoạn văn bản ta dùng lệnh hay nút lệnh nào 

A. Format  Number 

B. Format  Bullets and Numbering 

C. Click vào nút  

D. Câu B, C đúng 

Câu 41. Để tạo các kí tự đặc biệt đầu đoạn văn bản ta dùng lệnh hay nút lệnh nào 

A. Format - Number and Number 
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B. Click vào nút  

C. Câu A, B đúng 

D. Câu B, C sai 

Câu 42. Để canh trái đoạn văn bản ta dùng 

A. Ctrl – L 

B. Click nút  

C. Format  Paragraph  Alignment  Left 

D. Các câu trên đều đúng 

Câu 43.  Để canh đều 2 bên đoạn văn bản ta thực hiện 

A. Ctrl – J 

B. Click nút Justify 

C. Format/Paragraph/Alignment/Justified 

D. Các câu trên đều đúng 

Câu 44. Để canh giữa trang đoạn văn bản ta thực hiện 

A. Ctrl – E 

B. Click nút Center 

C. Format / Paragraph / Alignment/Center 

D. Các câu trên đều đúng 

Câu 45. Để canh đoạn văn bản Theo lề phải trang giấy ta thực hiện 

A. Ctrl – R 

B. Click nút Align Right 

C. Format / Paragraph / Alignment/Right 

D. Các câu trên đều đúng 

Câu 46. Để tạo/Bỏ chỉ số trên ta nhấn nút hay gõ tổ hợp phím 

A. Ctrl – Shift - +/= 

B. Format / Font / Superscript 

C. Các câu A, B đều đúng 

D. Các câu A, B đều sai 

Câu 47. Để tạo/Bỏ chỉ số dưới ta nhấn nút hay gõ tổ hợp phím 

A. Ctrl – +/= 

B. Format  Font  Subscript 

C. Các câu A, B đều sai 

D. Các câu A,B đều đúng 

Câu 48. Trong văn bản cột Để ngắt cột bắt buộc ta dùng lệnh hay nhấn tổ hợp phím tắt nào 

A. Ctrl – + 

B. Format  Column  Break 
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C. Các câu A,B đều sai 

D. Các câu A, B đều đúng 

Câu 49. Trong văn bản cột. Để ngắt cột bắt buộc ta dùng lệnh hay nhấn tổ hợp phím tắt nào 

A. Ctrl – Shift - Enter 

B. Insert  Break  Columm Break 

C. Các câu A,B đều sai 

D. Các câu A, B đều đúng 

Câu 50. Trong Excel, với bảng dữ liệu theo hình vẽ để tính Tuổi cho sinh viên, ta sử dụng công 

thức nào sau đây? 

A. =YEAR(TODAY()) – YEAR(C2) 

B. =YEAR(2011) – YEAR(C2) 

C. =YEAR(C2) – YEAR(TODAY()) 

D. =YEAR(TODAY) – YEAR(C2) 

Câu 51. Trong Excel, với bảng dữ liệu theo hình vẽ để tính trung bình giá trị Sau Thuế cho mặt 

hàng Gạo, ta sử dụng công thức nào sau đây? 

¶ 

 

A. =DAVERAGE(A2:H8,H1,I1:I2) 

B.  =DAVERAGE(A1:H8,H1,I1:I2) 

C. =DAVERAGE(A1:H8,H1,I2) 

D.  =DAVERAGE(A1:H8,H2,I1:I2) 

Câu 52. Trong Excel, với bảng dữ liệu theo hình vẽ cho biết có tổng số bao nhiêu dòng Gạo, ta 

sử 
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dụng công thức nào sau đây? 

A. =COUNTIF(C1:C8,C1) 

B.  =COUNTIF(C1:C8,C4) 

C. =COUNTIF(C1:C8,C2) 

D.  =COUNTIF(C1:C8,C3)  

Câu 53. Trong Excel, ô A1 chức giá trị biểu thức ngày tháng năm như sau: 22/05/2011, giá trị 

trả về của công thức =DAY(A1) là bao nhiêu? 

A. 5 

B.   #VALUE! 

C. #NAME? 

D. 22  

Câu 54. Trong Excel, giá trị trả về của công thức =LEN(“ĐH KTCN”) là bao nhiêu? 

A. 8 

B.  7 

C. 9 

D. 6 

Câu 55. Trong Excel, với bảng dữ liệu theo hình vẽ, kết quả trả về ở ô I3 là bao nhiêu? 

A. 1 

B.  2 

C. 4 

D. 3 

Câu 56. Trong Excel, với bảng dữ liệu theo hình vẽ, kết quả trả về ở ô D4 là bao  nhiêu  khi 

copy công thức từ ô D3 xuống? 
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A. #NAME? 

B.  KHÔNG 

C. CÓ 

D. #VALUE! 

Câu 57. Trong Excel, với bảng dữ liệu theo hình vẽ để đếm số lượng học sinh dự thi ta sử 

dụng 

công thức nào? 

A. =COUNTA(A2:A8,A1) 

B. =COUNTIF(A2:A8,A4) 

C. =COUNTIF(C2:C8,C2) 

D. =COUNTA(A3:A4)  

Câu 58. Trong Excel, ô A1 chứa giá trị 8, công thức 

=IF(A1>=5, “TB”, IF(A1>=7, “Khá”, IF(A1>=8, “Giỏi”, “Xuất sắc”))) trả về kết quả bao 

nhiêu? 

A. Giỏi 

B.  TB 

C. Xuất sắc 

D. Khá 

Câu 59. Trong Excel, công thức =INT(AVERAGE(18,12,28,4)) trả về kết quả là bao nhiêu? 

A.  15 

B.  4 

C.  5.5 

D. 16 

Câu 60. Trong Excel, công thức =MIN(2,3,7,9,e) trả về kết quả là bao nhiêu? 

A.  #Name? 

B.  #Value! 

C.  2 

D. e 

Câu 61. Trong Excel, công thức =POWER(2,3) trả về kết quả là bao nhiêu? 
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A.   2 

B.   3 

C.   6 

D. 8  

Câu 62. Trong Excel, với bảng dữ liệu theo hình vẽ giá trị trả về của công thức 

=C2*IF(B2<22,15%,20%) ô D2 là bao nhiêu? 

A.   52.5 

B.   54 

C.   350 

D. 525 

Câu 63. Trong Excel, công thức =OR(5>4, 6<9, 2<1) trả về kết quả là bao nhiêu? 

A.  True 

B.  # VALUE 

C.   #Name? 

D. False 

Câu 64. Trong Excel, công thức =OR(5<4, 6<9, 2>1,AND(5<4, 6>9, 2<1)) trả về kết quả là bao 

nhiêu? 

A.   # Value! 

B.   False 

C.   #Name? 

D. True  

Câu 65. Trong Excel, ô A6 chứa chuỗi "8642791X12", công thức =VALUE(RIGHT(A6,7)) trả về 

giá trị là bao nhiêu? 

A.   0 

B.   #VALUE 

C.   Không xuất hiện gì cả. 

D.    8637736 Câu 66. Trong Excel, với bảng dữ liệu theo hình vẽ công thức 

=COUNTIF(A1:F1,”>0”) trả về kết  quả là bao nhiêu? 

 

A.   6 

B.  #Name? 

C. 4 

D. #Value! 
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Câu 67. Trong Excel, công thức =ABS(ROUND(3.1416,2)) trả về kết quả là bao nhiêu? 

A.   3.14 

B.   -13.14 

C.   6.2832 

D. 3.1416 

Câu 68. Trong Excel, ô A2 chứa số 86, ô A3 chứa  số 3, công thức  =MOD(A2/A3) trả về giá trị 

là  bao nhiêu? 

A.   2 

B. Excel báo lỗi cú pháp 

C.  0 

D. 28 

Câu 69. Trong Excel, với bảng dữ liệu theo hình vẽ để tính phí  bảo hành theo  qui định ký  tự 

thứ  3  là M thì được miễn còn lại thì 12% theo đơn giá và số lượng. Ta dùng công thức tổng quát 

nào sau đây? 

 

A. =IF(MID(B2,3,1="M",0,0.12*G2) 

B. =IF(MID B2,3,1)="M",0,0.12*D2*E2)  

C. =IF(MID(B2,3,1)="M",0,0.12*D2*E2) D. =IF(MID(B2,3,1="M",0,0.12*D2*E2) 

Câu 70. Trong Excel, với bảng dữ liệu theo hình vẽ công thức  =MAX($A1:$F2)  trả về kết  quả 

là bao nhiêu? 

 

A.   9 

B.   #Value! 

C.   10 

D. #Name? 

Câu 71. Trong Excel, với bảng dữ liệu theo hình vẽ công thức 

=IF(A1>=MAX($A$1:$G$1),”CO”,”KHONG”) trả về kết quả là bao nhiêu? 

A.   12 

B.  KHONG 

C.   6 

D. CO 
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Câu 72. Trong Excel, với bảng dữ liệu theo hình vẽ, công thức 

=VLOOKUP(LEFT(B2),$A$8:$F$10,IF(MID(B2,2,1)="N",2,4),0) sẽ cho kết quả là gì? 
 

 

A. HÓA CHẤT 

B. MỸ PHẨM 

C. SP NHỰA 

D. Các câu A, B, C đều  sai. 

Câu 73. Trong Excel, với bảng dữ liệu theo  hình vẽ  để đếm số  kho  DN, ta dùng công thức 

tổng  quát nào sau đây? 

 

A.   =SUMIF(A2:A5, “DN”) 

B. =COUNTA(A2:A5,"DN") 

C.   =SUMIF(A2:A5,"DN",B2:B5) 

D. =COUNTIF(A2:A5,A2)  

Câu 74. Trong Excel,  với bảng dữ liệu  theo  hình vẽ để tính trung bình thành tiền,  ta dùng 

công  thức nào sau đây? 

 

A.   = DAVERAGE(A1:D5,D5,A1:A5) 

B. =DAVERAGE(D2:D5) 

C.   =AVERAGE(D2:D5) 

D. = DAVERAGE(D2:D5,D1, A1:A5) 

Câu 75. Trong Excel có mấy loại dữ liệu 

A. 3 loại 

B. 5 loại 
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C. 6 loại 

D. Tất cả đều sai 

Câu 76. Trong Excel có mấy loại địa chỉ 

A. 2 loại 

B. 3 loại 

C. 1 loại 

D. Tất cả đều sai 

Câu 77. Trong Excel Để chọn rời rạc ta nhấn giữ phím nào trong khi chọn 

A. Shift 

B. Ctrl 

C. Alt 

D. Space 

Câu 78. Địa chỉ hổn hợp là địa chỉ 

A. Thay đổi khi sao chép 

B. Không thay đổi khi sao chép 

C.  

D. Các câu trên đều sai 

Câu 79. Trong Excel, các ô A1=”X”, A2=”01”, A3=”02” A4=”03”. Hãy cho biết kết quả của công 

thức sau: = COUNT(A2:A4) 

A. 6 

B. 0  

C. Sẽ báo có nhiều đối số 

D. Trong Excel không có hàm này 

Câu 80. Trong Excel, các ô A1=X, A2=”01”, A3=”02” A4=”03”. Hãy cho biết kết quả của Công 

thức sau : =SUM(A2:A4) 

A. 6 

B. 0 

C. Sẽ báo Value 

D. Sẽ báo Num 

Câu 81. Trong Excel, các ô A1=X, A2=”01”, A3=”02” A4=”03”. Hãy cho  biết kết quả của công  

thức sau: =COUNTA(A1:A4) 

A. 6 

B. 4  

C. 0 

D. Sẽ báo Num 

Câu 82. Trong Excel, các ô A1=X, A2=”01”, A3=”02” A4=”03”. Hãy cho biết kết quả của công 
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thức sau: 

=AVERAGE(A2:A4) 

A. 6 

B. 4 

C. 2 

D. Sẽ báo #DIV/0! 

Câu 83. Trong Excel để lấy n kí tự bên trái của chuỗi m ta dùng 

A. LEFT(n,m) 

B. RIGHT(m,n) 

C. LEFT(m,n)  

D. RIGHT(n,m) 

Câu 84. Trong Excel để lấy n kí tự bên phải của chuỗi m ta dùng 

A. LEFT(n,m) 

B. RIGHT(m,n)  

C. LEFT(m,n) 

D. RIGHT(n,m) 

Câu 85. Trong Excel để lấy n kí tự từ vị trí s của chuỗi m ta dùng 

A. LEFT(n,m) 

B. RIGHT(m,n) 

C. MID(m,s,n)  

D. MID(n,s,m) 

Câu 86. Trong Excel ô A1=”Truong Cao Dang Phat Thanh Truyen Hinh II”. Hãy cho biết kết quả 

của công thức sau: =MID(A1,8,8) 

A. Truyen Hinh 

B. Cao Dang  

C. Phat Thanh 

D. Dang Phat 

Câu 87. Trong Excel ô A1=”Truong Cao Dang Phat Thanh Truyen Hinh II” Để Trích chuỗi Phat 

Thanh Truyen Hinh II ta nhập 

A. =MID(A1,17,25) 

B. =LEFT(A1,17) 

C. =RIGHT(A1,25) 

D. Câu A, C Đúng 

Câu 88. Giả sử A3 = “A01B2”, Cho biết kết quả trả về của hàm sau 

=IF(mid(A3,2,2)= “01”, “ABC”, “DEF”) 

A. ABC  
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B. DEF 

C. AB 

D. Các câu trên đều sai 

Câu 89. Giả sử A3 = “A01B2”, Cho biết kết quả trả về của hàm sau: 

=IF(mid(A3,2,7)= “01B2”, “ABC”, “DEF”) 

A. ABC  

B. DEF 

C. AB 

D. Các câu trên đều sai 

Câu 90. Giả sử ô E6 có chứa dữ liệu chuỗi là ngày sinh 1  người (ví dụ: 12/12/1980, để biết 

tuổi  người đó ta nhập vào công thức sau: 

A. YEAR(TODAY()) - VALUE(RIGHT(E6,4)) 

B. YEAR(NOW()) - VALUE(RIGHT(E6,4)) 

C. YEAR(TODAY()) - RIGHT(E6,4) 

D. Các câu A, B, C đều đúng 

Câu 91. Giả sử các ô A1, A2, A3 có các giá trị lần lượt là 12, 28 và “PhatThanh”. Công thức 

=SUM(A1:A3) cho ta giá trị sau: 

A. 40  

B. 12 

C. Công thức sai, máy báo lỗi vì A3 là kiểu chuỗi 

D. Các câu A, B, C đều sai 

Câu 92. Kết quả của hàm: LEFT(“12AB012”, 3)  

A. 012  

B. 12A 

C. 12 

D. Các câu trên đều sai 

Câu 93.   Kết quả của hàm: RIGHT(“ACB192A”,4) 

A. 192A  

B. ACB1 

C. A291 

D. Các câu trên đều sai 

Câu 94. Trong Excel, các ô A1 = 30, A2 = 4, A3 = “AQ”, A4 = 2. Hãy cho biết kết quả của công 

thức sau: =COUNT(A1:A4) 

A. 4 

B. 3  

C. 2 
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D. 1 

Câu 95. Trong Excel, các ô A1 = 30, A2 = 4, A3 = “AQ”, A4 = 2. Hãy cho biết kết quả của công 

thức sau: =COUNTA(A1:A4) 

A. 4  

B. 3 

C. 2 

D. 1 

Câu 96. Trong Excel, các ô A1 = 30, A2 = 30, A3 = “AQ”, A4 = 2. Hãy cho biết kết quả của công 

thức sau: =COUNTIF(A1:A4, “30”) 

A. 4 

B. 3 

C. 2 

D. 1  

Câu 97. Trong Excel, các ô A1= 20, A2 = X, A3 = 25. Cho biết kết quả sau = AVERAGE(A1:A3) 

A. 25 

B. 22,5  

C. 22 

D. Báo lỗi #NAME 

Câu 98. Trong Excel, giả sử ô A1 có giá trị ABCDE, muốn lấy 3 ký tự CDE ta dùng hàm nào 

sau đây: 

A.   = RIGHT(A1, 3) 

B.   = MID(A1, 3, 3) 

C. Cả câu a và b đều đúng. 

D. Cả câu a và b đều sai. 

Câu 99. Trong Excel, giả sử ô D4 có công thức sau: 

= HLOOKUP(A4, A10:D12, 5, TRUE) kết quả sai ở thành phần nào? 

A. Thành phần thứ 1. 

B. Thành phần thứ 2. 

C. Thành phần thứ 3. 

D. Thành phần thứ 4. 

Câu 100.Trong Excel, kết quả của hàm MOD(9,3) là: 

A. 3 

B. 1 

C. 0  

D. #N/A 
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Câu 101. Hệ thống nhớ của máy tính bao gồm: 

A. Bộ nhớ trong, Bộ nhớ ngoài 

B. Cache, Bộ nhớ ngoài 

C. Bộ nhớ ngoài, ROM 

D. Đĩa quang, Bộ nhớ trong 

Câu 102. Trong mạng máy tính, thuật ngữ Share có ý nghĩa gì? 

A. Chia sẻ tài nguyên 

B. Nhãn hiệu của một thiết bị kết nối mạng 

C. Thực hiện lệnh in trong mạng cục bộ 

D. Một phần mềm hỗ trợ sử dụng mạng cục bộ 

Câu 103. Cho biết cách xóa một tập tin hay thư mục mà không di chuyển vào Recycle 

Bin:? 

A. Chọn thư mục hay tâp tin cần xóa -> Delete 

B. Chọn thư mục hay tâp tin cần xóa -> Ctrl + Delete 

C. Chọn thư mục hay tâp tin cần xóa -> Alt + Delete 

D. Chọn thư mục hay tâp tin cần xóa -> Shift + Delete 

Câu 4. Các thiết bị nào thông dụng nhất hiện nay dùng để cung cấp dữ liệu cho máy xử 

lý? 

A. Bàn phím (Keyboard), Chuột (Mouse), Máy in (Printer)  

B. Máy quét ảnh (Scaner). 

C. Bàn phím (Keyboard), Chuột (Mouse) và Máy quét ảnh (Scaner). 

D. Máy quét ảnh (Scaner), Chuột (Mouse) 

Câu 105. Khái niệm hệ điều hành là gì ? 

A. Cung cấp và xử lý các phần cứng và phần mềm 

B. Nghiên cứu phương pháp, kỹ thuật xử lý thông tin bằng máy tính điện tử 

C. Nghiên cứu về công nghệ phần cứng và phần mềm 

D. Là một phần mềm chạy trên máy tính, dùng để điều hành, quản lý các thiết bị 

phần cứng và các tài nguyên phần mềm trên máy tính 

Câu 106. Trong soạn thảo Word, để kết thúc 1 đoạn (Paragraph) và muốn sang 1 đoạn 

mới : 

A. Bấm tổ hợp phím Ctrl – Enter 

B. Bấm phím Enter 

C. Bấm tổ hợp phím Shift – Enter 
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D. Word tự động, không cần bấm phím 

Câu 107. Bộ nhớ RAM và ROM là bộ nhớ gì? 

A. Primary memory 

B. Receive memory 

C. Secondary memory 

D.  Random access memory. 

Câu 108. Thiết bị nào sau đây dùng để kết nối mạng? 

A. Ram 

B. Rom 

C. Router 

D. CPU 

Câu 109. Dịch vụ lưu trữ đám mây của Microsoft là gì? 

A. Google Driver 

B. Mediafire 

C. OneDrive 

D. Cả 3 câu hỏi trên đều đúng. 

Câu 110. Danh sách các mục chọn trong thực đơn gọi là : 

A. Menu pad 

B. Menu options 

C. Menu bar 

D. Tất cả đều sai 

Câu 111. Công dụng của phím Print Screen là gì? 

A. In màn hình hiện hành ra máy in 

B. Không có công dụng gì khi sử dụng 1 mình nó. 

C. In văn bản hiện hành ra máy in 

D. Chụp màn hình hiện hành 

Câu 112. Trong soạn thảo Word, công dụng của tổ hợp phím Ctrl – S là: 

A. Tạo một văn bản mới 

B. Chức năng thay thế nội dung trong soạn thảo 

C. Định dạng chữ hoa 

D. Lưu nội dung tập tin văn bản vào đĩa 

Câu 113. Trong soạn thảo Word, tổ hợp phím nào cho phép đưa con trỏ về cuối văn 

bản 
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A. Shift + End 

B. Alt + End 

C. Ctrl + End 

D. Ctrl + Alt + End 

Câu 114. Trong soạn thảo Word, để chèn các kí tự đặc biệt vào văn bản, ta thực hiện: 

A. View – Symbol 

B. Format – Symbol 

C. Tools – Symbol 

D. Insert – Symbol 

Câu 115. Nếu bạn muốn làm cho cửa sổ nhỏ hơn (không kín màn hình), bạn nên sử 

dụng nút nào? 

A. Maximum 

B. Minimum 

C. Restore down 

D. Close 

Câu 116. Trong soạn thảo Word, muốn tách một ô trong Table thành nhiều ô, ta thực 

hiện: 

A. Table – Merge Cells 

B. Table – Split Cells 

C. Tools – Split Cells 

D. Table – Cells 

Câu 117. Trong soạn thảo Word, sử dụng phím nóng nào để chọn tất cả văn bản: 

A. Alt + A 

B. Ctrl + A 

C. Ctrl + Shift + A 

D. Câu 1 và 2 

Câu 118. Trong soạn thảo Word, muốn đánh dấu lựa chọn một từ, ta thực hiện : 

A. Nháy đúp chuột vào từ cần chọn 

B. Bấm tổ hợp phím Ctrl – C 

C. Nháy chuột vào từ cần chọn 

D. Bấm phím Enter 
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Câu 119. Trong bảng tính Excel, cho các giá trị như sau: ô A4 = 4, ô A2 = 5, ô A3 = 6, ô 

A7 = 7 tại vị trí ô B2 lập công thức B2 = Sum(A4,A2,Count(A3,A4)) cho biết kết quả ô 

B2 sau khi Enter: 

A. 10 

B. 9 

C. 11 

D. Lỗi 

Câu 120. Người đọc biết tập tin đang mở là phiên bản cuối cùng và chỉ cho phép đọc, 

bạn chọn? 

A. File -> info -> Protect Document -> Restrict Editing 

B. Review ->Restrict Editing -> Editing restrictions -> No changes (Read only) 

C. File -> info -> Protect Document -> Mark as Final 

D. File -> info -> Protect Document -> Encrypt as Password 

Câu 121. Thuộc tính phần mềm microsoft word 2010 có phần mở rộng là gì? ( Cho 

phép chọn nhiều) 

A. .doc 

B. .docx 

C. .dot 

D. .txt 

Câu 122. Câu nào sau đây sai khi nhập dữ liệu vào bảng tính Excel thì: 

A. Dữ liệu kiểu số sẽ mặc nhiên canh thẳng lề trái 

B. Dữ liệu kiểu ký tự sẽ mặc nhiên canh thẳng lề trái 

C. Dữ liệu kiểu thời gian sẽ mặc nhiên canh thẳng lề phải 

D. Dữ liệu kiểu ngày tháng sẽ mặc nhiên canh thẳng lề phải. 

Câu 123. Trong soạn thảo Word, thao tác nào sau đây sẽ kích hoạt lệnh Paste (Chọn 

nhiều đáp án) 

A. Tại thẻ Home, nhóm Clipboard, chọn Paste 

B. Bấm tổ hợp phím Ctrl + H. 

C. Chọn vào mục trong Office Clipboar 

D. Tất cả đều đúng 

Câu 124. Phần mềm nào có thể soạn thảo văn bản với nội dung và định dạng như sau: 

”Công cha như núi Thái Sơn 

Nghĩa mẹ như nước trong nguồn chảy ra. 
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Một lòng thờ mẹ kính cha, 

Cho tròn chữ hiếu mới là đạo con.” 

A. Notepad 

B. Microsoft Word 

C. WordPad 

D. Tất cả đều đúng 

Câu 125. Trong bảng tính Excel, để lưu tập tin đang mở dưới một tên khác, ta chọn: 

A. File / Save As 

B. File / Save 

C. File / New 

D. Edit / Replace 

Câu 226. Trong bảng tính Excel, ô A1 chứa nội dung “TTTH ĐHKHTN”. Khi thực hiện 

công thức = LEN(A1) thì giá trị trả về kết quả: 

A. 6 

B. 11 

C. 5 

D. 0 

Câu 127. Trong bảng tính Excel, tại ô A2 có giá trị số 25; Tại ô B2 gõ vào công thức 

=SQRT(A2) thì nhận được kết quả: 

A. 0 

B. 5 

C. #VALUE! 

D. #NAME! 

Câu 128. Trong soạn thảo Word, để chọn một đoạn văn bản ta thực hiện: 

A. Click 1 lần trên đoạn 

B. Click 2 lần trên đoạn 

C. Click 3 lần trên đoạn 

D. Click 4 lần trên đoạn 

Câu 129. Trong bảng tính Excel, ô A1 chứa giá trị 7.5. Ta lập công thức tại ô B1 có nội 

dung như sau =IF(A1>=5, “Trung Bình”, IF(A1>=7, “Khá”, IF(A1>=8, “Giỏi”, “Xuất 

sắc”))) khi đó kết quả nhận được là: 

A. Giỏi. 
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B. Xuất sắc. 

C. Trung Bình 

D. Khá 

Câu 130. Trong bảng tính Excel, hàm nào dùng để tìm kiếm: 

A. Vlookup 

B. IF 

C. Left 

D. Sum 
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